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5.1	 �INTRODUCTION

5.1.1	 �Background

The 1990 Nutrition Labeling and Education Act man-
dated nutritional labeling of most foods. As a result, a 
large portion of food analysis is performed for nutri-
tional labeling purposes. Interpretation of these regu-
lations (21 CFR 101.9) and the appropriate usage of 
rounding rules, available nutrient content claims, ref-
erence amounts, and serving size can be challenging. 
Additionally, during the product development pro-
cess, the effect of formulation changes on the nutrition 
label may be important. As an example, a small change 
in the amount of an ingredient may determine if a 
product can be labeled low fat. As a result, the ability 
to immediately approximate how a formulation 
change will impact the nutritional label can be valu-
able. In some cases, the opposite situation may occur 
and a concept called reverse engineering is used. In 
reverse engineering the information from the nutrition 
label is used to determine a formula for the product. 
Caution must be used during reverse engineering. In 
most cases, only an approximate formula can be 
obtained and additional information not provided by 
the nutrition label may be necessary.

The use of nutrient databases and computer pro-
grams designed for preparing and analyzing nutrition 
labels can be valuable in all of the situations described 
earlier. In this laboratory you will use a computer pro-
gram to prepare a nutrition label from a product for-
mula, determine how changes in the formula affect the 
nutrition label, and observe an example of reverse 
engineering.

5.1.2	 �Reading Assignment

Metzger, L.E. and Nielsen, S.S., 2017. Nutrition label-
ing. Ch. 3, in Food Analysis, 5th ed. S.S. Nielsen (Ed.), 
Springer, New York.

5.1.3	 �Objective

Prepare a nutrition label for a yogurt formula, deter-
mine how formulation changes will affect the nutrition 
label, and observe an example of reverse engineering.

5.1.4	 �Materials

TechWizard™  – Formulation and Nutrition Labeling 
Software for Microsoft Excel for Windows.

Owl Software. TechWizard™ Software Manual, 
Columbia, MO. www.owlsoft.com

5.1.5	 �Notes

Instructions on how to receive and install the software 
used for this laboratory are located online at www.
owlsoft.com, under the Academic link located in the 

heading. It is possible that the TechWizard™ program has 
been updated since the publication of this laboratory manual 
and any changes in the procedures described below will also 
be found on this web page.

*Install the software prior to the laboratory ses-
sion to ensure that it works properly with your PC.

5.2	 �PREPARING NUTRITION LABELS 
FOR SAMPLE YOGURT FORMULAS

5.2.1	 �Procedure

	 1. 	Start the TechWizard™ program. (Start the pro-
gram, the message appears “TechWizard success-
fully opened the necessary files…” and click 
OK. Click on the Enter Program button. Select User 
Name “Administrator” and click OK.)

	 2. 	Enter the Nutrition Labeling section (From the 
Labeling tab select Labeling Section. You should see 
“TechWizard™ – Nutrition Info & Labeling with 
New Formats” in the top left corner of the screen.)

	 3. 	Enter the ingredients for Formula #1 listed in 
Table  5.1. (Click on the Add Ingredients button, 
then select an ingredient from the ingredient list 
window, and click the Add button. Repeat for each 
ingredient. After all the ingredients have been added, 
close the window.)

	 4. 	Enter the amounts of the ingredients. (Enter the 
percentage of each ingredient for Formula #1 in the 
% (wt/wt) column. Selecting the Sort button above 
that column and then Sort Descending will sort the 
ingredients by the % (wt/wt) in the formula.)

	 5. 	Enter the serving size (common household unit 
and the equivalent metric quantity) and number 
of servings. (First click on the Serving Size button 
under Common Household unit, enter 2/3  in the 
window, click on OK, and select cup from the units 
drop down list; next click on the Serving Size button 
under Equivalent Metric Quantity, enter 170 g  in 
the window, click on OK, and select g from the units 

	� Sample yogurt formulas

Formula #1 (%) Formula #2 (%)

Milk (3.7 % fat) 38.201 48.201
Milk (skim), no vit. A 

add
35.706 25.706

Milk (skim), condensed 
(35 % TS)

12.888 12.888

Sweetener, sugar 
(Liquid)

11.905 11.905

Modified starch 0.800 0.800
Stabilizer, gelatin,  

dry powder, 
unsweetened

0.500 0.500
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drop down list; and finally click on the Number of 
Servings button, enter 1 in the window, and click on 
OK.)

	 6. 	Save Formula #1. (Click on the File tab, then 
Formula, and then Save Formula As. Type Student 
Name_Formula Name in the Formula Name win-
dow, click the Save button, then OK, and close the 
window.)

	 7. 	View the nutrition label and select label 
options. (Click on the View Label button, click on 
the Label Options button, and select Standard; 
select Protein -- Show ADV for voluntary nutri-
ents since yogurt is high in protein, and enter 1 
for the PDCAAS; when you have finished selecting 
the label options, select Apply, then OK, and then 
Close to view the label.)

	 8. 	Copy and paste the nutrition label for formula #1 
to a Microsoft Word file (Click on the Copy button 
on the Labeling tab, select Standard Label, Enter 1 for 
the new label format. Click OK. When prompted that 
the label has been copied, click OK. Open a Word doc-
ument, and type the name of the formula and paste the 
label. Return to the TechWizard™ program.)

	 9. 	Edit the ingredient declarations list (Click on 
the View/Edit Declaration button, and click Yes 
when asked – Do you wish to generate a simple 
formula declaration using individual ingredi-
ent declarations?  – Each ingredient used in the 
formula can be selected in the top window and the 
ingredient declaration can be edited in the middle 
window.)

*�Note the rules for ingredient declaration are found in 
21 CFR 101.4.

	 10. 	Copy and paste the ingredient declaration for 
Formula #1 to a Microsoft Word file. (Select Edit 
Formula declaration, and click the Copy button then 
OK to the pop-up and close the window. The declara-

tion can now be pasted into your Microsoft Word 
Document).

	11. 	Return to the Nutrition Info & Labeling section 
of the TechWizard™ program. (Go to the 
TechWizard™ program and click on the Return 
button.)

	12. 	Repeat the process for Formula #2 (Table  5.1). 
(Repeat Steps 4–10)

5.3	 �ADDING NEW INGREDIENTS 
TO A FORMULA AND  
DETERMINING HOW THEY 
INFLUENCE THE NUTRITION 
LABEL

Sometimes it may be necessary to add additional ingre-
dients to a formula. As an example, let us say you 
decided to add an additional source of calcium to yogurt 
formula #1. After contacting several suppliers, you 
decided to add Fieldgate Natural Dairy Calcium 1000, a 
calcium phosphate product produced by First District 
Association (Litchfield, MN), to the yogurt formula. This 
product is a natural dairy-based whey mineral concen-
trate and contains 25 % calcium. You want to determine 
how much Dairy Calcium 1000 you need to add to have 
50 and 100 % of the Daily Value (DV) of calcium in one 
serving of your yogurt. The composition of the Dairy 
Calcium 1000 you will add is shown in Table 5.2.

5.3.1	 �Procedure

	 1. 	Add the name of the new ingredient to the data-
base. (From the Edit Ingredient File tab, select Edit 
Current File; Click on Edit Ingredient File tab again 
in the Ingredients group; Click Add, type the ingre-
dient name “Dairy Calcium 100_Student Name” in 
the Enter Ingredient Name box, and click Add. 
Answer Yes to the question, and click OK. Close the 
window.)

	 2. 	Enter the new ingredient composition 
(Table 5.2). (Select the ingredient name in the col-
umn named “Ingredients and Properties.” Click 
Edit Selected in the Ingredients group under the Edit 
Ingredient File tab, the row will turn blue, and enter 
the amount of each component/nutrient in the appro-
priate column.)

	 3. 	Edit the ingredient declaration (which will 
appear on the ingredient list) for the new ingre-
dient. (Type “Whey mineral concentrate” in the col-
umn named “Default, Spec TEXT, zzzIngredient 
Declaration.”)

	 4. 	Save the changes to the ingredient file. (Click 
on the Finish Edit button, and answer Yes to the 
question. Select Close Ingred. File from the Edit 
Ingredient File tab.)

	� Composition of Fieldgate Natural Dairy 
Calcium 1000 (First District Association)

Component Amount

Ash (%) 75
Calcium (mg/100 g) 25,000
Calories (cal/100 g) 40
Lactose (%) 10
Phosphorus (mg/100 g) 13,000
Protein (g/100 g) 4.0
Sugars (g/100 g) 10
Total carbohydrates (g/100 g) 10
Total solids (%) 92
Water (%) 8.0
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	 5. 	Open food analysis formula #1 in the Formula 
Development Section of the program. (Click 
the Formula Dev and Batching tab, and then 
Formula Dev. From the File menu, select Open 
Formula and select your Formula #1 file “Student 
Name_Formula Name,” click on the Open button, 
then click on No for the first question, and click on 
Yes for the remaining questions). 

	 6. 	Add the new Dairy Calcium 1000 ingredient to 
your food analysis formula #1. (Click on the Add 
Ingredients button, then select your ingredient 
“Dairy Calcium 1000_Student Name” from the 
ingredient list, click on the Add button, and close the 
window.)

	 7. 	Calculate the amount of calcium (mg/100g) 
required to meet 50 and 100 % of the DV (see 
example below):

	
Calcium required

DV for calcium
serving size

g of DV re

�
�

�
�

�

�
�

� �100 % qquired

	

	

Calcium required for of the DV
mg
g

g

50
1300
170

100 0 50

%

.














 

	

Calcium required for of the DV
mg

g
50 382

100
% 













	

	 8.	 Enter the amount of calcium required in the for-
mula and restrict all ingredients in the formula 
except skim milk and Dairy Calcium 1000. (Find 
Calcium in the Property column and enter 382 in the 
Min and Max columns for Calcium. This lets the 
program know that you want to have 382 mg of cal-
cium per 100 g. In both the Min and Max columns of 
the Ingredients, enter 38.201 for Milk (3.7 % fat); 
12.888 for Milk (skim), condensed (35 % TS); 
11.905 for Swtnr, sugar (Liquid); 0.800 for 
Modified starch; and 0.500 for Stblzr, Gelatin, dry 
powder, unsweetened. This lets the program 
adjust the amount of skim milk and Dairy Calcium 
1000 (calcium phosphate) and keeps the amount of all 
the other ingredients constant. Click on the Formulate 
button, click OK.). Record the % wt/wt for Dairy 
Calcium to answer Question 2 in Sect. 5.5.

	 9.	 Save the modified formula with your name. 
(Click on the File tab, then Formula, and then Save 
Formula As. Type “Student Name_Formula #1 
added calcium 50 % DV” in the Formula Name 
window, click the Save button, then OK to close the 
window.)

	10. 	Open the new formula into the nutrition label-
ing section. (Click on the Labeling tab, select 

Labeling Section, click the File tab then Open 
Formula, and select your formula “Student Name_
Formula #1 added calcium 50 % DV,” and click 
Open then click on No for the first question, and 
click on Yes for the remaining questions).

	11. 	Make sure you have the correct serving size 
information (see Sect. 5.2, Step 5).

	12. 	View and print the nutrition label for the new 
formula with 50 % of the calcium DV.  Follow 
the instructions described in Sect. 5.2, Steps 
6–10.

	13. 	Produce a formula and label that has 100 % of 
the calcium DV. (Repeat Steps 8–12 except using 
the calculated amount of calcium required to meet 
100 % of the calcium DV. You will have to perform 
this calculation yourself following the example in 
Step 7.)

5.4	 �AN EXAMPLE OF REVERSE 
ENGINEERING IN PRODUCT 
DEVELOPMENT

5.4.1	 �Procedure

In this example the program will automatically go 
through the reverse engineering process. (Start the 
example by selecting Cultured Products Automated 
Examples from the Help menu and clicking on example #4. 
During this example you proceed to the next step by clicking 
on the Next button.) Each step is described below:

	 1. 	The information from the nutrition label for the 
product you want to reverse engineer is entered 
into the program. (Comment: In this example serv-
ing size, calories, calories from fat, total fat, satu-
rated fat, cholesterol, sodium, total carbohydrate, 
sugars, protein, vitamin A, vitamin C, calcium, and 
iron are entered.)

	 2. 	The minimum and maximum levels of each 
nutrient are calculated on a 100-g basis. 
(Comment: The program uses the rounding rules to 
determine the possible range of each nutrient on a 
100-g basis.)

	 3. 	The information about nutrient minimum and 
maximums is transferred into the Formula 
Development section of the program. (Comment: 
The program has now converted nutrient range 
information into a form it can use during the formu-
lation process.)

	 4. 	Ingredients used in the formula are then 
selected based on the ingredient declaration 
statement on the nutrition label. (Comment: 
Selecting the right ingredients can be difficult and 
an extensive understanding of the ingredient decla-
ration rules is necessary. Additionally some of the 
required ingredients may not be in the database and 
will need to be added.)

Chapter 5 • Nutrition Labeling Using a Computer Program
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	 5. 	Restrictions on the amount of each ingredient in 
the formula are imposed whenever possible. 
(Comment: This is a critical step that requires 
knowledge about the typical levels of ingredients 
used in the product. Additionally, based on the order 
of ingredients in the ingredient declaration, approxi-
mate ranges can be determined. In this example, the 
amount of modified starch is limited to 0.80 %, the 
amount of gelatin is limited to 0.50 %, and the 
amount of culture is limited to 0.002 %.)

	 6. 	The program calculates an approximate for-
mula. (Comment: The program uses the information 
on nutrient ranges and composition of the ingredi-
ents to calculate the amount of each ingredient in the 
formula.)

	 7. 	The program compares the nutrition informa-
tion for the developed formula to the original 
nutrition label. (Comment: This information is 
viewed in the Nutrition Label to Formula Spec sec-
tion of the program accessed by selecting Reverse 
Engineering Section from the Reverse Engineering 
tab. Click the X to close the Cultured Products 
Example window when finished.)

5.5	 �QUESTIONS

	 1. 	Based on the labels you produced for yogurt 
Formula #1 and Formula #2  in Sect. 5.2, what 
nutrient content claims could be made for each 

formula (see 21 CFR 101.13, Nutrient content 
claims – general principles – and 21 CFR 101-54-
101.67, Specific requirements for nutrient con-
tent claims or summary tables from the FDA or 
other sources based on these CFR sections)?

	 2. 	How much Dairy Calcium 1000 did you have to 
add to the yogurt formula to have 50 and 100 % 
of the DV of calcium in the formula?

	 3. 	If Dairy Calcium 1000 costs $2.50/lb and you 
are going to have 100 % of the DV for calcium in 
your yogurt, how much extra will you have to 
charge for a serving of yogurt to cover the cost 
of this ingredient?

	 4. 	Assume you added enough Dairy Calcium 1000 
to claim 100 % of the DV of calcium, would you 
expect the added calcium to cause any texture 
changes in the yogurt?

	 5. 	Make a nutrition label using the chocolate chip 
cookie recipe and other information in Table 5.3 
(for simplicity assume 0 % loss of water during 
baking, number of servings = 1, serving size = 30 
g). Conversion factors to get the weight of sugars 
and salt can be found in the US Department of 
Agriculture Nutrient Database for Standard 
Reference website: http://ndb.nal.usda.gov/. 
When adding ingredients to the formula, you may 
have to select the tab “USDA Ingredients as Source” 
in the Add Ingredients window to find the ingredient 
you need. Enter the grams of each ingredient in the 
%(wt/wt) column. Select Normalize from the Labeling 
tab to convert the values so the total is 100. The ingre-
dient, Candies, semisweet chocolate, does not 
have Added Sugars data. You can enter a tempo-
rary value to the ingredient information to calcu-
late the Nutrition Facts. Click on Composition from 
the Labeling tab. In the row for that ingredient, scroll 
to the right until you find the column for Added 
Sugars with the units g. Enter the value you determine 
for Added Sugars (hint: look at the Sugars value) and 
click the Enter key. The value will be used for the 
label but is not saved in the ingredient file.

RESOURCE MATERIALS

Metzger LE, Nielsen SS (2017) Nutrition labeling. Ch. 3. In: 
Nielsen SS edn. Food analysis, 5th edn. Springer, New York

Owl Software TechWizard™ Manual, Columbia, MO. www.
owlsoft.com

	� Recipe for chocolate chip cookies

Ingredients Amount Grams

Wheat flour, white, 
all-purpose, enriched, 
unbleached

2.25 cups 281.25

Swtnr, sugar, granulated 0.75 cup
Candies, semisweet 

chocolate
100 g 100

Sugars, brown 0.75 cup (packed)
Butter (salted) 1 cup 227
Egg, whole, fresh 2 units 112
Salt 0.75 tsp

Source for ingredients: TechWizard, USDA ingredients as 
source
Conversion data source: USDA web page
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